PDA Software
Getting Started Guide
The information in this document is subject to change without notice and should not be construed as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any errors that may appear in this document. This manual is believed to be complete and accurate at the time of publication. In no event shall Waters Corporation be liable for incidental or consequential damages in connection with, or arising from, the use of this manual.

© 1997, 1999 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA. ALL RIGHTS RESERVED. THIS BOOK OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

LAC/E and PowerStation are trademarks and Millennium and Waters are registered trademarks of Waters Corporation.

Windows, Windows NT, and Windows 98 are trademarks and Microsoft is a registered trademark of Microsoft Corporation.

All other trademarks are the sole property of their respective owners.
# Table of Contents

How to Use This Guide ........................................................................................................ 9

Chapter 1
PDA Software Overview .................................................................................................. 15
  1.1 What Is PDA Software? ......................................................................................... 15
  1.2 Tutorial Overview ............................................................................................... 17
  1.3 Restoring the PDA Project .................................................................................. 18

Chapter 2
Viewing PDA Data ........................................................................................................... 23
  2.1 Tutorial Overview ............................................................................................... 23
  2.2 Viewing Data in Review ..................................................................................... 23
  2.3 Displaying the 3D Plot ....................................................................................... 29
  2.4 Zooming In on Plots ......................................................................................... 35
  2.5 Extracting a Chromatogram .............................................................................. 38
  2.6 Extracting a Spectrum ....................................................................................... 41

Chapter 3
Peak Purity Processing .................................................................................................. 48
  3.1 Tutorial Overview ............................................................................................... 48
  3.2 Deriving a Max Plot Chromatogram ................................................................. 50
  3.3 Building a PDA Processing Method ................................................................... 54
  3.4 Reviewing Peak Purity Results .......................................................................... 65
Chapter 4
Library Matching ................................................................. 76
  4.1 Tutorial Overview............................................................ 76
  4.2 Creating a New Library .................................................... 79
  4.3 Matching Spectra to a Library ......................................... 86
  4.4 Reviewing Library Matching Results ............................... 103

Chapter 5
Printing Reports ................................................................. 109
  5.1 Previewing a Report.......................................................... 109
  5.2 Background Printing........................................................ 113

Index  ......................................................................................... 116
List of Figures

1-1 Millennium\textsuperscript{32} Login Window ................................................................. 19
1-2 Millennium\textsuperscript{32} Login Dialog Box................................................................. 19
1-3 Configuration Manager .............................................................................................. 20
1-4 Restore Project Wizard - Start Software Page ......................................................... 21
1-5 Configuration Manager with Restored PDA_Default Project .............................. 22

2-1 Millennium\textsuperscript{32} Login Window ........................................................................ 24
2-2 Project Window in Review Data Selection Mode ..................................................... 25
2-3 Review with Unprocessed Data ................................................................................. 26
2-4 Maximized Review Main Window ............................................................................. 27
2-5 Millennium\textsuperscript{32} Review Tools ......................................................................... 28
2-6 Absorbance Keys and Legend .................................................................................. 30
2-7 Sample 3D Plot Window ......................................................................................... 31
2-8 Sample 3D Plot Window (Front View) ..................................................................... 32
2-9 Sample 3D Plot Window (Side View) ....................................................................... 33
2-10 Sample 3D Plot Window (Top View) ...................................................................... 34
2-11 Drawing the Zoom Box ......................................................................................... 35
2-12 Zoomed View of the Contour Plot .......................................................................... 36
2-13 Plot Properties Dialog Box for the Contour Plot .................................................. 37
2-14 Scaling Property Tab ............................................................................................... 38
2-15 Wavelength Marker ............................................................................................... 39
2-16 Extracted Chromatogram at Wavelength 254 nm .............................................. 40
2-17 Overlaid Chromatograms at Wavelengths 254 and 280 nm ............................. 41
2-18 Spectrum Marker .................................................................................................. 42
2-19 Extracted Spectrum ............................................................................................... 43
2-20 Extracted Spectra Overlaid ..................................................................................... 44
2-21 Spectral Table ......................................................................................................... 45
2-22 Normalized Spectra ............................................................................................... 46
2-23 Viewing Spectrum Points: Absorbances Versus Wavelengths...................... 47
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1</td>
<td>Steps in Peak Purity Testing</td>
</tr>
<tr>
<td>3-2</td>
<td>Minimized PDA_Default Project</td>
</tr>
<tr>
<td>3-3</td>
<td>Project Window with PDA_Default Project</td>
</tr>
<tr>
<td>3-4</td>
<td>Review Main Window</td>
</tr>
<tr>
<td>3-5</td>
<td>Max Plot Chromatogram</td>
</tr>
<tr>
<td>3-6</td>
<td>Processing Method Wizard Dialog Box</td>
</tr>
<tr>
<td>3-7</td>
<td>New Processing Method Dialog Box</td>
</tr>
<tr>
<td>3-8</td>
<td>Setting the Integration Time</td>
</tr>
<tr>
<td>3-9</td>
<td>Integration - Peak Width and Threshold Page</td>
</tr>
<tr>
<td>3-10</td>
<td>Rejecting Peaks</td>
</tr>
<tr>
<td>3-11</td>
<td>Setting the Minimum Height</td>
</tr>
<tr>
<td>3-12</td>
<td>Calibration - General Page</td>
</tr>
<tr>
<td>3-13</td>
<td>PDA Purity/Matching Page</td>
</tr>
<tr>
<td>3-14</td>
<td>PDA Spectral Contrast Page</td>
</tr>
<tr>
<td>3-15</td>
<td>Setting the Noise Interval</td>
</tr>
<tr>
<td>3-16</td>
<td>Processing Method Name Page</td>
</tr>
<tr>
<td>3-17</td>
<td>Integrated Chromatogram in the Chromatogram Plot</td>
</tr>
<tr>
<td>3-18</td>
<td>Purity Angle and Purity Threshold Values in the Peaks Table</td>
</tr>
<tr>
<td>3-19</td>
<td>Apex Spectrum</td>
</tr>
<tr>
<td>3-20</td>
<td>Apex Spectra Overlaid with Maximum Impurity Spectra</td>
</tr>
<tr>
<td>3-21</td>
<td>Maximum Impurity Spectrum with Peak 1 Apex Spectrum Zoomed</td>
</tr>
<tr>
<td>3-22</td>
<td>Maximum Impurity Spectrum with Peak 2 Apex Spectrum Zoomed</td>
</tr>
<tr>
<td>3-23</td>
<td>Maximum Impurity Spectrum with Peak 3 Apex Spectrum Zoomed</td>
</tr>
<tr>
<td>3-24</td>
<td>Results Window</td>
</tr>
<tr>
<td>3-25</td>
<td>Purity Plot</td>
</tr>
<tr>
<td>3-26</td>
<td>Plot Properties Dialog Box</td>
</tr>
<tr>
<td>3-27</td>
<td>Purity Plot with Maximum Impurity Indicator</td>
</tr>
</tbody>
</table>
4-1 Steps in Creating a Library ............................................................ 77
4-2 Steps in Library Matching ............................................................ 78
4-3 Selecting Data for a Library .......................................................... 79
4-4 Review Main Window..................................................................... 80
4-5 Open an Existing Method Set Dialog Box...................................... 81
4-6 Apply Method Set Tool................................................................. 81
4-7 Paraben Stds Chromatogram ........................................................ 82
4-8 Library Cascade Menu ................................................................. 82
4-9 Create a New Library Dialog Box .................................................. 83
4-10 Spectrum Review with Spectra Selected ....................................... 84
4-11 Spectrum Review Menus .............................................................. 85
4-12 Add Spectrum to Library Dialog Box.............................................. 85
4-13 Project Window with PDA_Default ................................................. 87
4-14 Review Main Window..................................................................... 88
4-15 Open an Existing Method Set Dialog Box...................................... 89
4-16 Apply Method Set Tool................................................................. 89
4-17 Integrated Max Plot Chromatogram for Mixture............................. 90
4-18 Processing Method Window ......................................................... 91
4-19 PDA Library Search Property Tab................................................ 92
4-20 Processing Method Wizard Dialog Box ......................................... 93
4-21 New Processing Method Dialog Box.............................................. 93
4-22 Setting the Integration Time........................................................... 94
4-23 Integration - Peak Width and Threshold Page ............................... 95
4-24 Rejecting Peaks ............................................................................. 95
4-25 Setting the Minimum Height........................................................... 96
4-26 Calibration - General Page ........................................................... 97
4-27 PDA Purity/Matching Page .......................................................... 97
4-28 PDA Spectral Contrast Page.......................................................... 98
4-29 Setting the Noise Interval............................................................... 99
4-30 PDA Match Library Page ............................................................. 99
4-31 Processing Method Name Page ..................................................... 100
4-32 Integrated Chromatogram in the Chromatogram Plot.................. 101
4-33 Library Matching Results ............................................................. 102
4-34 Spectrum Index with Library Matching........................................ 104
4-35 Overlaid Spectra ........................................................................ 105
4-36 Library Match Table with Results .............................................. 106
4-37 Library Match Plot for Each Peak ............................................... 107
4-38 Triple Plot: Library Match ............................................................. 108

5-1 Project Window............................................................................ 110
5-2 Report Publisher Dialog Box........................................................ 110
5-3 Open Report Method Dialog Box................................................... 111
5-4 Preview ........................................................................................ 112
5-5 Project Window............................................................................ 113
5-6 Background Processing and Reporting Dialog Box ..................... 114
5-7 Sample Report............................................................................. 115
How to Use This Guide

Purpose of This Guide

The *PDA Software Getting Started Guide* describes the basics of how to use the PDA option with the Millennium®32 software. Using a standard set of data for the 996 detector, this guide takes you through the steps of developing a PDA processing method for peak purity and library matching.

Audience

This guide is intended for a wide variety of users whose familiarity with computers and software ranges from novice to expert. You should understand the principles of chromatography.

Structure of This Guide

The *PDA Software Getting Started Guide* contains five chapters. Every chapter page is marked with a tab and a footer to help you find information.

The following table describes the material covered in each chapter of this guide:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, PDA Software Overview</td>
<td>Describes the Millennium®32 PDA software.</td>
</tr>
<tr>
<td>Chapter 2, Viewing PDA Data</td>
<td>Describes the basics of viewing PDA data.</td>
</tr>
<tr>
<td>Chapter 3, Peak Purity Processing</td>
<td>Describes how to derive a Max Plot chromatogram and how to develop a peak purity processing method.</td>
</tr>
<tr>
<td>Chapter 4, Library Matching</td>
<td>Describes how to create a spectral library and match samples to the library.</td>
</tr>
<tr>
<td>Chapter 5, Printing Reports</td>
<td>Describes the basics of printing reports.</td>
</tr>
</tbody>
</table>
Related Documentation

Online Documentation

The following table describes the online documentation that supports the Millennium\textsuperscript{32} software.

<table>
<thead>
<tr>
<th>Title</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Millennium\textsuperscript{32} Online Help</td>
<td>Describes all Millennium\textsuperscript{32} windows, menus, menu selections, and dialog boxes for the base software and all the software options. Also includes reference information and procedures for performing all tasks required to use the Millennium\textsuperscript{32} software. Included as part of the Millennium\textsuperscript{32} software.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} Read Me File</td>
<td>Describes product features and enhancements, helpful tips, installation and/or configuration considerations, and changes since the previous Millennium software version.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} LIMS Online Help</td>
<td>Describes how to use the Millennium\textsuperscript{32} LIMS Interface to export results and import worklists.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} Toolkit Professional Online Help</td>
<td>Describes how to use the common object model, message-based protocol to communicate with the Millennium\textsuperscript{32} software from a third-party application.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} WebServer Online Help</td>
<td>Describes how to use the Millennium\textsuperscript{32} WebServer application.</td>
</tr>
</tbody>
</table>
Printed Base Documentation

The following table describes the printed documents that make up the Millennium\textsuperscript{32} software base documentation.

<table>
<thead>
<tr>
<th>Title</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Millennium\textsuperscript{32} Read Me First</td>
<td>Describes the Millennium\textsuperscript{32} software documentation, software license, hardware warranty, support, and training.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} Software Getting Started Guide</td>
<td>Provides an introduction to the Millennium\textsuperscript{32} system. Describes the basics of how to use Millennium\textsuperscript{32} software to acquire data, develop a processing method, review results, and print a report. Also covers basic information for managing projects and configuring systems.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} Software Data Acquisition/Processing Theory Guide</td>
<td>Provides theories pertaining to data acquisition, peak detection and integration, and quantitation of sample components.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} System Installation/Configuration Guide</td>
<td>Describes Millennium\textsuperscript{32} software installation, including the stand-alone workstation, PowerStation\textsuperscript{TM} system, and client/server system. Discusses how to configure the computer and chromatographic instruments as part of the Millennium\textsuperscript{32} system. Also covers the installation, configuration, and use of acquisition servers such as the LAC/E\textsuperscript{32} module, the busLAC/E\textsuperscript{TM} card, and interface cards used to communicate with serial instruments.</td>
</tr>
<tr>
<td>Millennium\textsuperscript{32} Release Notes</td>
<td>Contains last-minute information about the product. Also provides supplementary information about specific Millennium\textsuperscript{32} software releases.</td>
</tr>
</tbody>
</table>
Printed Options Documentation

The following table describes the printed documents that support Millennium\textsuperscript{32} software options.

<table>
<thead>
<tr>
<th>Title</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Millennium\textsuperscript{32} System Suitability Quick Reference Guide</strong></td>
<td>Describes the basics of the Millennium\textsuperscript{32} System Suitability software application and describes the equations used by the System Suitability software.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} GPC Software Getting Started Guide</strong></td>
<td>Describes how to use the Millennium\textsuperscript{32} GPC software option to develop a GPC processing method and to review GPC results.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} GPCV Software Getting Started Guide</strong></td>
<td>Describes how to use the Millennium\textsuperscript{32} GPCV software option to develop a GPCV processing method and to review GPCV results.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} Pattern Matching Software Getting Started Guide</strong></td>
<td>Describes how to use the Chromatographic Pattern Matching software option to develop a pattern matching processing method and to review pattern match results.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} Dissolution Software Quick Start Guide</strong></td>
<td>Describes how to operate the Alliance Dissolution System using Millennium\textsuperscript{32} software.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} Tablet Processing Software User's Guide</strong></td>
<td>Describes how to operate the Millennium\textsuperscript{32} Tablet Processing Software with a Source for Automation Solid Dosage Assay System.</td>
</tr>
<tr>
<td><strong>Integrity System Getting Started Guide</strong></td>
<td>Describes the features of the Waters\textsuperscript{®} Integrity System and provides step-by-step tutorials that guide a user through the use of the Millennium\textsuperscript{32} Mass Spectrometry (MS) software option.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} Toolkit Programmer's Reference Guide</strong></td>
<td>Describes how to use the common-object-model, message-based protocol to communicate with the Millennium\textsuperscript{32} software from a third-party application.</td>
</tr>
<tr>
<td><strong>Millennium\textsuperscript{32} Alpha/Intel Client/Server System for Microsoft Windows NT Administrator's Guide</strong></td>
<td>Describes how to administer Millennium\textsuperscript{32} software client/server tasks in an NT Alpha or Intel client/server system.</td>
</tr>
</tbody>
</table>
Related Adobe™ Acrobat Reader Documentation

For detailed information about using the Adobe Acrobat Reader, refer to the Adobe Acrobat Reader Online Guide. This Online Guide covers procedures such as viewing, navigating and printing electronic documentation from Adobe Acrobat Reader.

Printing From This Electronic Document

Adobe Acrobat Reader lets you easily print pages, pages ranges, or the entire electronic document by selecting Print from the File menu. For optimum print quantity, Waters recommends that you specify a Postscript printer driver for your printer. Ideally, use a printer that supports 600 dpi print resolution.

Conventions Used in This Guide

This guide uses the following conventions to make text easier to understand.

- **Purple Text** indicates user action. For example:
  
  Press 0, then press Enter for the remaining fields.

- *Italic* text denotes new or important words, and is also used for emphasis. For example:
  
  An *instrument method* tells the software how to acquire data.

- **Underlined, Blue Color** text indicates hypertext cross-references to a specific chapter, section, subsection, or sidehead. Clicking this topic using the hand symbol automatically brings you to this topic within the electronic document. Right-clicking and selecting Go Back from the popup context menu brings you back to the originating topic. For example:
  
  Modify the existing processing method to include library matching, as described in Chapter 4, Library Matching.
Notes, Attentions, and Cautions

• Notes call out information that is important to the operator. For example:

   **Note:** Record your results before you proceed to the next step.

• Attentions provide information about preventing possible damage to the system or equipment. For example:

   **Attention:** To avoid damaging the detector flow cell, do not touch the flow cell window.

• Cautions provide information essential to the safety of the operator. For example:

   **Caution:** To avoid chemical or electrical hazards, always observe safe laboratory practices when operating the system.

   **Caution:** To avoid the possibility of electrical shock and possible injury, always turn off the detector and unplug the power cord before performing maintenance procedures.

   **Caution:** To avoid the possibility of burns, turn off the lamp at least 30 minutes before removing it for replacement or adjustment.
1
PDA Software Overview

This chapter describes the basic features of the Millennium® 32 software for the PDA detector, the goals of this tutorial, and the process for loading sample PDA data on your workstation. Once you have loaded the sample data, you can view and manipulate the data in a variety of ways, as described in Chapter 2, Viewing PDA Data.

1.1 What Is PDA Software?

The Millennium® 32 Photodiode Array Detector (PDA) software enables you to use the Millennium® 32 software to acquire and process spectral and chromatographic data. You use the PDA software with the Waters® 996 PDA Detector.

Features of the PDA Software

The Millennium® 32 System is a total chromatography and results management system that you can adapt to your individual chromatography requirements. The Millennium® 32 System consists of the following components:

- A computer that runs Millennium® 32 software. The three basic hardware configurations are:
  - Workstation
  - PowerStation™
  - Client/Server
- Millennium® 32 software
- Millennium® 32 database

The Millennium® 32 PDA software is an integrated part of the Millennium® 32 software. PDA data acquisition, processing, and reporting with the PDA software requires use of the base LC Millennium® 32 software.

Features of the Base LC Millennium® 32 Software

Millennium® 32 software provides a graphical, icon-based user interface to acquire, process, and manage chromatographic data. All user actions are performed by pointing and clicking with the mouse (keyboard shortcuts are also supported).

What Is PDA Software? 15
Millennium\textsuperscript{32} software supports Windows 98\textsuperscript{TM} and Windows NT\textsuperscript{TM} and multitasking operation, providing you with the ability to have multiple windows open at the same time. You can view a real-time data acquisition run while simultaneously producing summary results of previously acquired data, or fine-tuning integration parameters for the last injection performed.

The base LC Millennium\textsuperscript{32} software provides tools for:

- Creating projects
- Configuring chromatographic systems
- Developing instrument methods to control chromatographic systems
- Acquiring data from samples and standards
- Developing a processing method to perform integration, calibration, and quantitation
- Processing data and obtaining results
- Creating report methods to generate custom reports
- Viewing and printing reports
- Backing up, deleting, restoring, and copying the contents of an individual project

**Millennium\textsuperscript{32} Software Reference Information**

You can perform additional procedures for data acquisition, processing, and report generation depending on the complexity of your application. Refer to the Millennium\textsuperscript{32} Online Help for more information. For information on using the Millennium\textsuperscript{32} Online Help, refer to the Millennium\textsuperscript{32} Read Me First that comes with the Millennium\textsuperscript{32} software. For an overview on the Millennium\textsuperscript{32} software, refer to the Millennium\textsuperscript{32} Software Getting Started Guide.

**PDA Software Functions**

The Millennium\textsuperscript{32} PDA software supports the following functions:

- **PDA Instrument Dialog Box** – Defines control parameters for the Waters 996 Photodiode Array Detector.
- **Real-time PDA Data Acquisition Displays** – Plot the latest acquired spectra and wavelength in QuickSet for up to four individual real-time data acquisition plots.
- **3D Blank Subtraction** – Allows you to use a method set to subtract a labeled 3D chromatogram (a solvent blank) from a second 3D chromatogram (a sample or standard) and display the difference in Review. This feature is useful for subtracting the effects of a mobile phase containing strong UV absorbing compounds.
- **PDA Calibration** – Allows you to examine the wavelength calibration, the reference spectrum and dark current, and the effects of exposure time on photodiode saturation.
• **PDA Diagnostics** – Allows you to run internal and external diagnostics on the 996 detector.

• **Review** – Allows you to view your chromatograms and spectra by using the Contour plot, which allows you to extract, integrate, and process 3D chromatograms/spectra, and the Spectrum Index plot, which displays selected spectra for the peaks shown in the Chromatogram plot. Also displays the maximum impurity for multiple PDA purity passes.

**Spectrum Review Spectral Plot** – Displays library, peak, and extracted spectra in Review, searches against library spectra, creates derived spectra, and creates and maintains spectral libraries.

**Spectrum Review Tables** – Display spectral and match results data in Review, such as the:

- Spectral table with an image of all extracted spectra and peak apex spectra with complete data on each spectrum
- Library Match table with the results of the library search
- Spectrum Points table with the wavelength range and resolution used to acquire PDA data

### 1.2 Tutorial Overview

This tutorial shows you how to:

- Load PDA data from the Millennium® Photodiode Array Option CD-ROM. This data is used in all the examples in this guide.
- Extract chromatograms and spectra.
- Develop a processing method.
- Calculate peak purity and examine peak purity results.
- Build a UV spectral library and match unknown spectra to spectra in the library.
- Generate a report.

This guide assumes that you have already acquired PDA data as described in the Millennium® Software Getting Started Guide. This guide does not cover acquiring data, optimizing integration, generating calibration curves, quantitating unknowns, and getting results for 2D chromatograms. For details on these topics, refer to the Millennium® Software Getting Started Guide.
Before You Begin

Before you perform the procedures described in this guide, make sure that:

- You installed the Millennium$^{32}$ software as described in the Millennium$^{32}$ System Installation/Configuration Guide.
- You installed the PDA software option as described in the Millennium$^{32}$ System Installation/Configuration Guide, Chapter 3, Installing the Software.
- You reviewed and followed the basic operating procedures, including data acquisition, described in the Millennium$^{32}$ Software Getting Started Guide.
- You read the Waters 996 PDA Detector Operator’s Guide.
- Your printer is properly configured in the Millennium$^{32}$ software.

1.3 Restoring the PDA Project

The PDA project, called PDA_Default, contains sample PDA data used in all the examples in this guide. You need the PDA project to run the examples. Use the Restore program in the Millennium$^{32}$ software and your own backup software to restore the project data to your workstation. The PDA project is located on the Millennium$^{32}$ Photodiode Array Option CD-ROM.

As part of the restore procedure, you must start your backup program. You can configure the Millennium$^{32}$ software to automatically start a user-configured backup program or Microsoft® Backup. For details, refer to the “Configuring Your Backup Utility in Millennium$^{32}$ Software” topic in the Millennium$^{32}$ Online Help Find tab.

To restore the PDA project, follow these steps:

1. Turn on the computer monitor, then turn on the CPU. The Windows 98 or Windows NT desktop appears.
2. Click Start, then select Programs, Millennium 32, and Millennium 32 Login from the cascade menus. The Millennium$^{32}$ Login window appears (Figure 1-1).
3. Click Login and enter your user name and password in the Millennium$^{32}$ Login dialog box (Figure 1-2), then click OK. If you do not know your user name or password, see your system administrator.

4. The Millennium$^{32}$ Login window reappears. Right-click Configure System (Figure 1-1), then select Projects from the context menu. The Configuration Manager appears (Figure 1-3).
5. Click the **Restore** tool (Figure 1-3) to start the Restore Project Wizard. The Restore Project Wizard appears (Figure 1-4). Note the directory specified in the Restore Project Wizard - Start Software page that indicates from where the backup set should be restored.

6. Click the second option button, then use the browse button to select the path of your CD-ROM drive as shown in Figure 1-4. The drive letter may be different.
1. Click **Next** in the Restore Project Wizard - Start Software page.

   **Note:** For details, refer to the Restoring a Project Using the Wizard topic in the Millennium Online Help Find tab.

2. Follow the instructions on each page of the wizard and click **Next** after you complete each page.

3. Click **Finish** on the last page to complete the restoration. The restored project, PDA_Default, appears in the Configuration Manager Projects View pane (Figure 1-5).

   **Note:** You may need to refresh the Configuration Manager by selecting **Refresh** from the View menu.
You are now ready to view the PDA data using the Millennium software as described in Chapter 2, Viewing PDA Data.
Viewing PDA Data

This chapter provides step-by-step procedures for viewing chromatograms and spectra.

2.1 Tutorial Overview

The goal of this tutorial is to show you the basics of using the Millennium® 32 software to view the PDA_Default data. Now that you have restored the PDA sample data to your Millennium® 32 workstation, you can examine it in a variety of ways. The procedures in this chapter are the building blocks for using the PDA software and are used as a foundation for the procedures in Chapter 3, Peak Purity Processing, and Chapter 4, Library Matching. This chapter describes the simple tasks you can do to view the PDA data that comes with the Millennium® 32 software, including:

- Using Review and viewing the Contour plot
- Displaying the 3D plot
- Zooming in on plots
- Extracting a chromatogram
- Extracting a spectrum

2.2 Viewing Data in Review

Review is the Millennium® 32 software application that lets you view and manipulate 2D and 3D chromatographic data brought in from the Project window. Review consists of menus, toolbars, the Chromatogram plot, Channel tables, the Contour plot, the Spectrum Review Spectral plot, Spectrum Review tables, and an Absorbance Legend. Each item is explained in this section.
To view a PDA data file in Review:

1. In the Millennium$^{32}$ Login window, select **PDA_Default** from the Project drop-down list (Figure 2-1).

   **Note:** If PDA_Default does not appear in the Project drop-down list, check that you restored it according to Section 1.3, Restoring the PDA Project. You can also click the **Browse Project** button in the Millennium$^{32}$ Login window and search for the project.

![Figure 2-1 Millennium$^{32}$ Login Window](image)

2. Right-click **Review Data**. Select **Review** from the context menu, then **Channels** from the cascade menu.
The Project window appears in Review Data selection mode (Figure 2-2).

![Figure 2-2 Project Window in Review Data Selection Mode](image-url)
3. Select **Mixture** in the SampleName field in the Channels View table, then click the **Review** button (Figure 2-2). Review appears with the unprocessed data in a screen similar to the one shown in Figure 2-3.

![Figure 2-3 Review with Unprocessed Data](image)

4. Select **3D Layout** from the View menu to view the Contour plot. The Contour plot appears (Figure 2-4). The Contour plot is an overhead view of the three-dimensional data file in which the x-axis plots time and the y-axis plots wavelength.

5. Maximize Review, then maximize the Review Main window for a full view of the window. You may also need to use the mouse to move the right edge of the window to get a complete view of the screen. A full view of Review appears (Figure 2-4).
6. Click the **3D Channels** tab at the bottom of Review (Figure 2-4) to view information regarding the data file, such as sample name, type, date, time acquired, etc.
Figure 2-5 shows the tools that you can use as shortcuts in the Millennium³² PDA software Review application.
2.3 Displaying the 3D Plot

The 3D plot provides a three-dimensional view of PDA data. The data is plotted on three axes: the X-axis represents time, the Y-axis represents absorbance units, and the Z-axis represents wavelength.

You can rotate the 3D plot to view the data from three different perspectives:

- The front view displays a chromatogram with time plotted on the X-axis and absorbance units plotted on the Y-axis.
- The side view displays the UV spectra with wavelength plotted on the X-axis and absorbance units plotted on the Y-axis.
- The top view displays a contour plot with time plotted on the X-axis and wavelength plotted on the Y-axis.

To display the 3D plot, follow these steps:

1. Follow the steps to display the PDA data in Review as described in Section 2.2, Viewing Data in Review.
2. Click the Legend tab on the lower-right side of Review (Figure 2-6) to display the legend for the absorbance. The legend defines the colors used in the Contour plot and the 3D plot.
3. Click the 3D Plot tool (see Figure 2-6) to view the 3D plot. Figure 2-7, Figure 2-8, Figure 2-9, and Figure 2-10 show a sample 3D plot from four different perspectives.
Figure 2-7  Sample 3D Plot Window

- **X-Axis** Represents Time
- **Y-Axis** Represents Absorbance Units
- **Z-Axis** Represents Wavelength
- Handle for Rotating 3D Plot
- Close Button
Handle for Rotating 3D Plot

Close Button

Y-Axis Represents
Absorbance Units

X-Axis Represents
Time

Figure 2-8 Sample 3D Plot Window (Front View)
Figure 2-9 Sample 3D Plot Window (Side View)
4. Drag the handle on the top of the plot to rotate the 3D plot (Figure 2-7).
5. Click the Close button in the upper-right corner to exit the 3D Plot window.
2.4 Zooming In on Plots

You can examine graphical plot features in detail by using a zoom box. You can zoom in on the Chromatogram plot, Contour plot, and Spectral plot. You also use this technique to view baseline noise in a chromatogram.

To create a zoom box, hold the left mouse button down and drag the mouse around the features you want to enlarge. A box appears around the area of interest (Figure 2-11). When the box has reached the desired size, release the left mouse button.

Figure 2-11 Drawing the Zoom Box
Figure 2-12 shows the area after zooming.

Figure 2-12  Zoomed View of the Contour Plot

Rescaling the Plot

To revert to the unzoomed plot, click the Full View or Unzoom tool (Figure 2-12) or right-click in the Contour Plot and select Unzoom or Full View from the context menu. Unzoom undoes the last zoom when you have zoomed repeatedly, whereas Full View reverts the plot to its original scale in one operation.
Saving Zoom Parameters

If you repeatedly want to see the same zoomed area, you can save the parameters of the zoom box. To save the zoom parameters, use the Scaling tab in the Plot Properties dialog box as follows:

1. Right-click the desired plot, then select Properties from the context menu. The Plot Properties dialog box appears as shown in Figure 2-13.

Figure 2-13 Plot Properties Dialog Box for the Contour Plot
2. In the Plot Properties dialog box, click the Scaling property tab. The Scaling tab appears as shown in Figure 2-14.

![Figure 2-14 Scaling Property Tab](image)

3. Click Get Values from Plot. The software fills in values from the plot in the Scaling property tab. Click OK.

*Note:* For details on how to customize display settings, refer to the “Customizing the Display of Data in Review” topic in the Millennium Online Help Find tab.

### 2.5 Extracting a Chromatogram

Extracting a chromatogram manually allows you to see what the chromatogram looks like at any wavelength across the collected wavelength range. You can extract chromatograms from several wavelengths and then overlay them for further comparison.

To manually extract a chromatogram:

1. Follow the steps to display the PDA data in Review as described in Section 2.2, Viewing Data in Review.
2. Click the **Extract Chromatogram** tool (Figure 2-15). A marker similar to the one in Figure 2-15 appears.

![Figure 2-15 Wavelength Marker](image-url)
3. Drag the wavelength marker to the desired wavelength or double-click the marker and enter the desired wavelength, for example, 254, then press Enter. A chromatogram at the desired wavelength appears in the Chromatogram plot (Figure 2-16).

4. Click the Extract Chromatogram tool again. Double-click the marker and enter the new desired wavelength, for example, 280.
5. To overlay the chromatograms, click the **Overlay** tool (Figure 2-16). The overlaid chromatograms appear in the Chromatogram plot as shown in **Figure 2-17**.

6. Click the **Overlay** tool again to see the extracted chromatogram at one wavelength.

   ![Two Markers Indicate a Chromatogram Extracted at Two Different Wavelengths](image)

**Figure 2-17** Overlaid Chromatograms at Wavelengths 254 and 280 nm

### 2.6 Extracting a Spectrum

When you extract a spectrum manually, you can see what the spectrum looks like at any time point in the chromatographic run. You can extract a spectrum at several elution times and then overlay them for further comparison. You can also use extracted spectra to build spectral libraries.

*Extracting a Spectrum* 41
To manually extract a spectrum:

1. Follow the steps to display the PDA data in Review as described in Section 2.2, Viewing Data in Review.
2. Click the Extract Spectrum tool (Figure 2-18). A marker similar to the one in Figure 2-19 appears in the lower-left corner of the Contour plot.

![Figure 2-18 Spectrum Marker]
3. Drag the time marker to the desired time or double-click the marker and enter the desired time, for example, 1.388 (the retention time of the first peak apex), then press Enter. The spectrum at that time appears in Spectrum Review (Figure 2-19).

Figure 2-19  Extracted Spectrum
4. Click the **Extract Spectrum** tool and repeat step 3, entering **2.159** for the retention time of the second peak apex. The next spectrum is overlaid with the previous spectrum in Spectrum Review (Figure 2-20).

---

**Figure 2-20** Extracted Spectra Overlaid
5. Click the **Spectra** tab on the lower-right side of the window (Figure 2-21) to view information about the spectra in Spectrum Review.
6. Double-click inside Spectrum Review to view the overlaid spectra in a normalized fashion. Note that the y-axis does not display absorbance units. Viewing the normalized spectra allows comparison of the UV spectra based on their shape differences (Figure 2-22).

You can restore the y-axis by double-clicking inside Spectrum Review.

![Normalized Spectra](image)

Figure 2-22  Normalized Spectra

7. In the Spectral table below Spectral Review, deselect all but one spectrum by clicking the Select check box (Figure 2-22).
8. Scroll in the area containing the tabs below the Spectral table (Figure 2-22) and click the Spectrum Points tab to display the absorbances at the wavelengths across the spectrum, as shown in Figure 2-23.

![Figure 2-23](image)

Figure 2-23  Viewing Spectrum Points: Absorbances Versus Wavelengths

9. Exit Review by clicking the Close button (Figure 2-23).
10. A dialog box warning that the modified method set cannot be saved appears. Click OK.

Next Steps

Now that you have examined the PDA_Default data in Review, you have the following options:

- You can develop a processing method for peak purity, as described in Chapter 3, Peak Purity Processing.
- You can create a spectral library and match unknown spectra against the library, as described in Chapter 4, Library Matching.
3
Peak Purity Processing

This chapter provides a tutorial with step-by-step procedures for developing a PDA processing method to determine peak purity.

3.1 Tutorial Overview

The goal of this tutorial is to familiarize you with Millennium® PDA software tools and procedures used to develop a PDA processing method for determining peak purity. You calculate peak purity to determine if a peak is spectrally homogeneous. Spectral heterogeneity may indicate the presence of a coelution. A coelution of two or more spectrally distinct compounds can produce a spectrally heterogeneous peak.

This tutorial shows you how to:

- Derive a chromatogram with maximum absorbances using a Max Plot chromatogram
- Develop a processing method to determine peak purity using the Processing Method Wizard, which is where you define key parameters for integration and peak purity determination
- Examine peak purity results in Spectrum Index
- View peak purity results in the Purity table and Purity plot of the Results window

Figure 3-1 shows the steps used to compute peak purity.
Figure 3-1  Steps in Peak Purity Testing
3.2 Deriving a Max Plot Chromatogram

Before developing a processing method that computes peak purity, you must derive a chromatogram. The chromatogram may be at a selected wavelength; however, we recommend that you use a Max Plot chromatogram, which plots the maximum spectral absorbance measured at each time point. The Max Plot chromatogram allows you to see all the chromatographic peaks in the sample regardless of lambda max (the wavelength at maximum absorbance).

To derive a Max Plot chromatogram:

1. Open the Project window, which you opened in Chapter 2, Viewing PDA Data, by clicking the minimized PDA_Default Project in the Windows taskbar (Figure 3-2).
2. In the Project window (**Figure 3-3**), double-click **Mixture** to bring Mixture into Review.

**Figure 3-3** Project Window with PDA_Default Project

The Review Main window appears (**Figure 3-4**).

<table>
<thead>
<tr>
<th>Vol</th>
<th>Injection</th>
<th>Sample Name</th>
<th>Sample Type</th>
<th>Sample Set Name</th>
<th>Date Acquired</th>
<th>Acq Method</th>
<th>Set</th>
<th>Channel</th>
<th>Channel Description</th>
<th>Channel ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>Mixture</td>
<td>Unknown</td>
<td></td>
<td>01/05/1995:6:44:38 PM</td>
<td>PeakPurity</td>
<td>596</td>
<td>1012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>Benzene Std</td>
<td>Unknown</td>
<td></td>
<td>01/05/1995:6:30:17 PM</td>
<td>PeakPurity</td>
<td>990</td>
<td>1008</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Phenone Std</td>
<td>Unknown</td>
<td></td>
<td>01/05/1995:6:32:02 PM</td>
<td>PeakPurity</td>
<td>996</td>
<td>1004</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Paraben Std</td>
<td>Unknown</td>
<td></td>
<td>01/05/1995:6:29:52 PM</td>
<td>PeakPurity</td>
<td>996</td>
<td>1016</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Extract a Max/Tic Plot Tool

Figure 3-4  Review Main Window
3. In the Review Main window, click the Extract a Max/Tic Plot tool at the top of the screen (Figure 3-4). The Max Plot Chromatogram appears in the chromatogram plot (Figure 3-5).
3.3 Building a PDA Processing Method

Now that you have extracted a max plot chromatogram, you can build a processing method to assess peak purity (see Figure 3-1). The simplest way to build a PDA processing method is by using the Processing Method Wizard.

To build a PDA processing method:

1. To start the wizard, click the Processing Method Wizard tool.
2. The Processing Method Wizard dialog box appears (Figure 3-6). Select the Create a New Processing Method radio button and click OK.

Figure 3-6 Processing Method Wizard Dialog Box
3. The New Processing Method dialog box appears (Figure 3-7). Choose **PDA** from the Processing Type drop-down list, make sure the Use Processing Method Wizard check box is selected, and then click **OK**.

![New Processing Method Dialog Box](image)

**Figure 3-7 New Processing Method Dialog Box**

4. The Integration - Integration Region page appears (Figure 3-8). Use this page to choose the part of the chromatogram over which you want to integrate. You must integrate the chromatogram to perform peak purity and to quantitate unknown samples later.

Use the mouse to select the entire chromatogram, being careful to move the mouse within the x- and y-axes. A faint line indicates the selected area. The software sets a Start and End time over which to integrate.

*Note: If you select the wrong integration region, right-click the chromatogram inside the x- and y-axes and select Full View. You can then reselect the integration region.*
5. Click **Next**. The Integration - Peak Width and Threshold page appears (Figure 3-9).
6. Click **Next**. The Integration - Peak Rejection page appears (Figure 3-10). Use this page to reject small peaks that are not of interest.
7. Move the mouse to the middle of the smallest peak of interest (Peak 2) and click it. The peak is highlighted in red. Click the **Minimum Height** check box to set the Minimum Height to 95% of the smallest peak of interest (Figure 3-11).
8. Click **Next**. The Calibration - General page appears (**Figure 3-12**).

---

**Figure 3-11** Setting the Minimum Height

**Figure 3-12** Calibration - General Page
9. In the Calibration - General page, click Next. Accept the default settings, then click Next on the successive pages until the PDA Purity/Matching page appears (Figure 3-13).

![Figure 3-13 PDA Purity/Matching Page](image)

10. Make sure the Yes option button is selected for the question “Do you wish to perform peak purity testing on all peaks?” (Figure 3-13). Click the No option button for the question “Do you wish to match spectra against PDA library spectra?”. Click Next. The PDA Spectral Contrast page appears (Figure 3-14).
11. Use the PDA Spectral Contrast page to set the noise interval by selecting a segment of the baseline that is free of peaks. You must select a segment of the baseline that is at least one-half minute in length. In this example, select the segment of the baseline including 3.00 to 3.50 minutes (Figure 3-15).

You can select the approximate baseline area by using the mouse to zoom in on the desired area, or you can select the exact baseline area by typing the start and end time of the desired area in the Noise Interval Start Time and Noise Interval End Time text boxes, respectively.

For details about selecting the noise interval, refer to the Determining the Noise Interval topic in the *Millennium*³² Online Help Find tab.
12. Click **Next**. The Processing Method Name page appears (**Figure 3-16**).
13. In the Method Name text box, type a processing method name, for example, *Purity*, then click **Finish**. The processing method is automatically saved and the Review Main window appears with max plot processed (Figure 3-17).

14. When working with a PDA processing method, you must save both the processing method and method set. The saved method set can then be applied to subsequent data to determine peak purity. To save the method set, select **Save As** from the File menu, then select **Method Set** from the cascade menu. Type a name in the text box, for example, *Purity*, then click **Save**.

**Figure 3-17 Integrated Chromatogram in the Chromatogram Plot**
15. Click the scroll arrows where indicated at the bottom left of the window to make the Peaks tab visible (see Figure 3-17). To view the numeric results of the peak purity calculation, click the Peaks tab at the bottom of the Review Main window (Figure 3-18).

16. Using the mouse, move the Chromatogram plot up to reveal more rows in the Peaks table. The Peaks table displays the Purity Angle and Purity Threshold values (Figure 3-18). If the Purity Angle and Purity Threshold values are not visible, scroll on the bottom right of the Peaks table to reveal them.

![Figure 3-18 Purity Angle and Purity Threshold Values in the Peaks Table](image-url)
17. If the Purity Angle is less than the Purity Threshold, the peak is spectrally homogeneous. Scroll down in the table to view the values for every integrated peak. Note that Peak 1 and Peak 2 are not spectrally homogeneous, whereas Peak 3 is spectrally homogeneous. For details on interpreting peak purity results, see the “Interpreting Peak Purity Results (PDA)” topic in the Millennium® Online Help Find tab.

The Millennium® PDA software automatically sets the Threshold Criteria to AutoThreshold. For details, refer to the “Threshold Criteria Considerations for Spectral Contrast (PDA)” topic in the Millennium® Online Help Find tab.

3.4 Reviewing Peak Purity Results

Once you have calculated peak purity, you can view the results in several ways. For example, you can examine the apex spectrum and the maximum impurity spectrum in Spectrum Index. Alternatively, you can use the Results window to examine the Purity plot to view the peak purity results.

3.4.1 Using Spectrum Index

Spectrum Index allows you to view the apex spectra of the integrated peaks. To view Spectrum Index:

1. In the Review Main window, click the Spectrum Index tab (Figure 3-19). The apex spectrum for each integrated peak appears and additional Spectrum Index tools appear above the Spectrum Index plot.

   Note: If the Spectrum Index tools do not appear, right-click the toolbar, then select Spectrum Index from the menu.
2. Click the **Maximum Impurity Pass 1** tool (see Figure 3-19). Spectrum Index appears with the maximum impurity spectrum (Figure 3-20). You are now viewing the apex spectrum overlaid with the spectrum within the integrated peak that differs most from the apex spectrum. This is displayed for every integrated peak. The dotted line in the Chromatogram plot indicates the location within each peak from where these spectra are taken. Spectrum Index also labels the lambda max, which is the wavelength at maximum absorbance.
Figure 3-20 Apex Spectra Overlaid with Maximum Impurity Spectra

Y-Axis Is Absorbance
X-Axis Is Wavelength

67 Peak Purity Processing
3. In the chromatogram plot, zoom in on the first peak and examine the overlaid spectra and note the slight differences between the spectra (Figure 3-21).

Figure 3-21 Maximum Impurity Spectrum with Peak 1 Apex Spectrum Zoomed
4. Scroll to the right and examine the spectra from the second peak and note the gross differences between the spectra (Figure 3-22).

Figure 3-22 Maximum Impurity Spectrum with Peak 2 Apex Spectrum Zoomed
5. Scroll to the right and examine the spectra from the third peak (Figure 3-23). The spectra overlay nicely. The first and second peaks need further investigation.

Figure 3-23 Maximum Impurity Spectrum with Peak 3 Apex Spectrum Zoomed
3.4.2 Using the Results Window

To view the Purity plot in the Results window:

1. Click the Results tool (Figure 3-23). The Results window appears (Figure 3-24). If necessary, maximize the Results window.

![Figure 3-24 Results Window]
2. Click the **Purity Plot** tab at the bottom of the Results window. The Purity plot (Figure 3-25) displays the chromatographic peak and plots the Purity Angle and the Purity Threshold across the peak. (If necessary, maximize the Purity Plot window.) Note that the left y-axis is in absorbance units and the right y-axis is in Spectral Contrast degrees.

![Figure 3-25 Purity Plot](image)

For a spectrally homogeneous peak, the Purity Angle is below the Threshold Angle. For the peak at 1.387 minutes, the Purity Angle is above the Threshold Angle in the early region of the peak, which indicates that the peak is not spectrally homogeneous.

The Purity Angle plot plots the Spectral Contrast Angle between the peak apex spectrum and the other peak spectra. For details, refer to the “Spectral Contrast Angle” topic in the *Millennium Online Help* Find tab. The Purity Angle increases in the peak tails due to the effects of baseline noise.

3. Scroll down in the Peaks table so you can click the next line in the Peaks table (Figure 3-25) to display the Purity plot for the next peak at 2.166 minutes.
4. Click the next line in the table at the top of the window to display the Purity plot for the next peak at 3.931 minutes.

5. Right-click the Purity plot, then select Properties from the context menu. The Plot Properties dialog box appears (Figure 3-26).

![Figure 3-26 Plot Properties Dialog Box](image)
6. In the Purity tab, select the **Annotate Peak Apex/Max. Impurity** check box, then click **OK**. The point of maximum impurity appears in the Results window (Figure 3-27). The peak apex is marked with a vertical line drawn from the apex of the peak perpendicular to the baseline.

![Figure 3-27 Purity Plot with Maximum Impurity Indicator](image)

The vertical line with the letter M indicates the point of maximum impurity.

7. Save the results so you can print them. To save the results, select **Save** from the **File** menu, then select **Result** from the cascade menu.

8. Exit Review by clicking the **Close** button.
Next Steps

Now that you have developed a processing method to assess peak purity, you have the following options:

- Modify the existing processing method to include library matching, as described in Chapter 4, Library Matching.
- Modify the processing method for multicomponent peak purity. For details, refer to the “Multicomponent Peak Purity Testing (PDA)” topic in the Millennium™ Online Help Find tab.
- Print your results, as described in Chapter 5, Printing Reports.
4
Library Matching

This chapter provides step-by-step tutorials describing the procedures for creating a library and matching unknown or acquired spectra to spectra in a library.

4.1 Tutorial Overview

The goal of these tutorials is to familiarize you with Millennium® software tools and procedures used to create a library and to match spectra to a library. Library matching allows you to identify peaks by comparing spectra from unknown peaks to spectra from known peaks. These tutorials show you how to:

- Create a library from existing standards
- Match unknown spectra to spectra in a library
- Review library matching results

Figure 4-1 shows the steps used to create a library. Figure 4-2 shows the steps used for library matching. If you followed the tutorial in Chapter 3, Peak Purity Processing, you can use the processing method that you developed and modify it to include library matching.
Figure 4-1 Steps in Creating a Library

1. Start
   - Select a PDA 3D Channel *(Section 4.2)*
   - Bring PDA_Data into Review *(Section 4.2)*
   - Open an Existing Method Set *(Section 4.2)*
   - Create a New Library *(Section 4.2)*
   - Add Spectra to the Library *(Section 4.2)*

2. End
Figure 4-2 Steps in Library Matching
4.2 Creating a New Library

You must create a library of known spectra before you can match unknown spectra to them. The first step in creating a library is to decide which spectra to add to the library. In this procedure, you add the spectra for Paraben Stds, Phenone Stds, and Benzoate Stds to the library.

To create a library:

1. In the Project window, which you opened in Chapter 2, Viewing PDA Data, select Paraben Stds, Phenone Stds, and Benzoate Stds from the Channels table, then click the Review tool (Figure 4-3). The Review Main window appears (Figure 4-4).  

   **Note:** If the Results window is not displayed, click the Review Main Window tool.

![Figure 4-3 Selecting Data for a Library](Image)
2. At the bottom of the Review Main window, click the **3D Channels** tab (Figure 4-4). Make sure Paraben Stds is selected.

3. Rearrange the Review Main window, if necessary, to bring the 3D Channels table into view. To enlarge the 3D Channels table, use the mouse to drag the bar above the 3D Channels table higher on the screen, as shown in Figure 4-4.
4. From the File menu, select **Open**, then select **Method Set**. The Open an Existing Method Set dialog box appears (Figure 4-5).

![Figure 4-5 Open an Existing Method Set Dialog Box](image)

5. Select **Purity** from the existing method set that you created in Chapter 3, Peak Purity Processing, then click **Open**. If you did not create the Purity method set, select **PDA_Demo_MethSet**. You need to use an existing method set to extract a chromatogram.

6. Click the **Apply Method Set** tool (Figure 4-6). The chromatogram for Paraben Stds appears in the Review Main window (Figure 4-7) and the apex spectra for the peaks appear in Spectrum Review.

![Figure 4-6 Apply Method Set Tool](image)
7. Select Library from the Spectrum Review menu, then select New Library from the cascade menu (Figure 4-8).

Figure 4-7 Paraben Stds Chromatogram

Figure 4-8 Library Cascade Menu
The Create a New Library dialog box appears (Figure 4-9).

8. Assign a name to the new library, for example, My Library, then click Create.
9. In the Spectral table, make sure that the check box in the Select column is selected as shown in Figure 4-10. The two spectra appear in the Spectrum Review (Figure 4-10).

![Figure 4-10 Spectrum Review with Spectra Selected](image)
10. From the Spectrum Review menu, select **Library**, then select **Add to library My Library** from the cascade menu (Figure 4-11).

![Figure 4-11 Spectrum Review Menus](image)

11. The Add Spectrum to Library dialog box appears (Figure 4-12). In the Name text box, enter **Methyl Paraben** for the name, then click **OK**.

![Figure 4-12 Add Spectrum to Library Dialog Box](image)

12. The Add Spectrum to Library dialog box reappears for the next spectrum. Enter **Ethyl Paraben** for the name, then click **OK**.
13. In the 3D Channels table, click the second row with Phenone Stds. The chromatogram for Phenone Stds appears. Repeat steps 9 and 10.

14. In the Add Spectrum to Library dialog box, enter Acetophenone for the name, then click OK.

15. The Add Spectrum to Library dialog box reappears for the next spectrum. Enter Propriophenone for the name, then click OK.

16. In the 3D Channels table, click the third row with Benzoate Stds. The chromatogram for Benzoate Stds appears. Repeat steps 9 and 10.

17. In the Add Spectrum to Library dialog box, enter Ethyl Paba for the name, then click OK.

18. The Add Spectrum to Library dialog box reappears for the next spectrum. Enter Benzoic Acid for the name, then click OK.

19. Select Exit from the File menu.

4.3 Matching Spectra to a Library

Now that you have created a spectral library, you can compare unknown spectra to spectra in the library. As Figure 4-2 shows, you can create a processing method in one of two ways:

- If you plan to use peak purity and library matching, you can modify the existing processing method that you created in Chapter 3, Peak Purity Processing, to include library matching. See Section 4.3.1, Modifying an Existing Processing Method for Library Matching.

- If you plan to do library matching only, you can create a processing method for library matching alone. See Section 4.3.2, Creating a New Processing Method for Library Matching.

When you have finished creating a processing method, proceed to Section 4.3.3, Performing Library Matching.
4.3.1 Modifying an Existing Processing Method for Library Matching

To modify the existing processing method:

1. In the Project window (Figure 4-13), which you opened in Chapter 2, Viewing PDA Data, double-click Mixture to bring Mixture into Review.
Review appears with the unprocessed data (Figure 4-14).

2. At the bottom of the Review Main window, click the 3D Channels tab (Figure 4-14).
3. From the File menu, select **Open**, then select **Method Set**. The Open an Existing Method Set dialog box appears (Figure 4-15).

![Open an Existing Method Set Dialog Box](image)

**Figure 4-15** Open an Existing Method Set Dialog Box

4. Select **Purity** from the existing method set that you created in **Chapter 3, Peak Purity Processing**, then click **Open**.

5. Click the **Apply Method Set** tool (Figure 4-16) to extract and process a Max Plot chromatogram.

![Apply Method Set Tool](image)

**Figure 4-16** Apply Method Set Tool
The chromatogram for Mixture is displayed in the Review Main window (Figure 4-17).

6. Click the **Processing Method** tool (see Figure 4-17) so you can modify the existing processing method for library matching.
7. The Processing Method window appears (Figure 4-18). If necessary, maximize the window. Click the **PDA Library Search** tab.

![Figure 4-18 Processing Method Window](image-url)
8. The PDA Library Search property tab appears (Figure 4-19). In the Library list box, click the check box of the library you want to search, for example, My Library (Figure 4-19).

9. Click the Review Main Window tool to return to the Review Main window.

10. To save the changes to the existing processing method, select Save from the File menu, then select Method from the cascade menu. To save the modified method under a different name, select Save As from the File menu, then select Method from the cascade menu. Type a name in the text box, for example, Purity_and_LibraryMatch, then click Save.

11. To save the modified method set under a different name, select Save As from the File menu, then select Method Set from the cascade menu. Type a name in the text box, for example, Purity_and_LibraryMatch, then click Save. When working with a PDA processing method, you have to save both the processing method and the method set.

12. Proceed to Section 4.3.3, Performing Library Matching, to complete the steps for library matching.
4.3.2 Creating a New Processing Method for Library Matching

If you plan to do library matching without peak purity, you can build a processing method for library matching alone. The simplest way to build a PDA processing method is by using the Processing Method Wizard.

To build a PDA processing method for library matching:

1. Before you start, you must derive a chromatogram as described in Section 2.5, Extracting a Chromatogram, or in Section 3.2, Deriving a Max Plot Chromatogram.

2. To start the wizard, click the Processing Method Wizard tool. The Processing Method Wizard dialog box appears (Figure 4-20).

![Figure 4-20 Processing Method Wizard Dialog Box](image)

3. Select the Create a New Processing Method radio button and click OK. The New Processing Method dialog box appears (Figure 4-21).

![Figure 4-21 New Processing Method Dialog Box](image)
4. Choose **PDA** from the Processing Type drop-down box and click **OK**. The Processing Method Wizard starts and the Integration - Integration Region page appears ([Figure 4-22](#)).

5. Choose the part of the chromatogram over which you want to integrate. You must integrate to perform library matching and to quantitate unknown samples later. Use the mouse to select the entire chromatogram, being careful to move the mouse within the x- and y-axes. A faint line indicates the zoomed area. The software sets a Start and End time over which to integrate ([Figure 4-22](#)).

6. Click **Next**. The Integration - Peak Width and Threshold page appears ([Figure 4-23](#)).
7. Click **Next**. The Integration - Peak Rejection page appears (Figure 4-24). Use this page to reject small peaks that are not of interest.
8. Move the mouse to the middle of the smallest peak of interest (Peak 2) and click it. Select the Minimum Height check box to set the Minimum Height to 95% of the smallest peak of interest (Figure 4-25).

Figure 4-25 Setting the Minimum Height
9. Click **Next**. The Calibration - General page appears (Figure 4-26).

![Figure 4-26 Calibration - General Page](image)

10. In the Calibration - General page, click **Next**. Click **Next** on the successive pages until the PDA Purity/Matching page appears (Figure 4-27).

![Figure 4-27 PDA Purity/Matching Page](image)
11. Click the **No** option button for the question “Do you wish to perform peak purity testing on all peaks?” Make sure that the **Yes** option button for the question “Do you wish to match spectra against PDA library spectra?” is selected. Click **Next**. The PDA Spectral Contrast page appears (Figure 4-28).

12. Use the PDA Spectral Contrast page to set the noise interval by selecting a segment of the baseline that is free of peaks. You must select a segment of the baseline that is at least one-half minute in length. In this example, select the segment of the baseline including 3.00 to 3.50 minutes (Figure 4-29).

You can select the approximate baseline area by using the mouse to zoom in on the desired area, or you can select the exact baseline area by typing the start and end time of the desired area in the Noise Interval Start Time and Noise Interval End Time text boxes, respectively.

For details about selecting the noise interval, refer to the Determining the Noise Interval topic in the *Millennium*® **Online Help** Find tab.

![Figure 4-28  PDA Spectral Contrast Page](image-url)
13. Click Next. The PDA Match Library page appears (Figure 4-30).
14. In the PDA Library Match page, click the check box for the library you want to match against, for example, My Library, then click Next. The Processing Method Name page appears (Figure 4-31).

![Figure 4-31 Processing Method Name Page](image)

15. In the Method Name text box, type a processing method name, for example, Library_Matching_Only, then click Finish. The method is automatically saved and the Review Main window appears with an integrated max plot chromatogram.

16. When working with a PDA processing method, you have to save both the processing method and method set. The saved method set can then be applied to subsequent data to determine peak purity. To save the method set, select Save As from the File menu, then select Method Set from the cascade menu. Type a name in the text box, for example, Library_Matching_Only, then click Save.
4.3.3 Performing Library Matching

Now that you have created or modified a processing method, you can perform library matching. Use the Millennium™ software Integrate function to compute the Match Angle and Threshold Angles for library matching.

1. If the Review Main Window is not displayed, click the Review Main Window tool (Figure 4-32).
2. Click the Apply Method Set tool. A screen similar to the one shown in Figure 4-32 appears.

![Figure 4-32 Integrated Chromatogram in the Chromatogram Plot](image)

Figure 4-32 Integrated Chromatogram in the Chromatogram Plot
3. Use the arrows at the bottom of the Peaks table to scroll until the Peaks tab appears (Figure 4-32). Click the Peaks tab (Figure 4-33). The Peaks table displays the results of library matching (Figure 4-33).

![Figure 4-33 Library Matching Results](image)

4. Scroll to the right of the Peaks table (Figure 4-33) to view the portion of the table that lists the match results, if necessary.

The Match Angle should be less than the Match Threshold to indicate a good match. A Match Angle greater than the Match Threshold indicates a poor match. For details, refer to the “Interpreting Library Matching Results (PDA)” topic in the Millennium™ Online Help Find tab. Match 1 is the closest match to a library spectrum; Match 2 is the next closest.
The Millennium\textsuperscript{32} PDA software sets the Threshold Criteria to Noise plus Solvent with the Solvent Angle set to one degree. For details, refer to the “Threshold Criteria Considerations for Spectral Contrast (PDA)” topic in the Millennium\textsuperscript{32} Online Help Find tab.

### 4.4 Reviewing Library Matching Results

Once you have determined library matching, you can view the results in several ways. For example, you can examine the apex spectra and the Triple plot by using Spectrum Index and the Results window respectively.

To view the library matching results:

1. Click the **Spectrum Index** tab. Spectrum Index appears in the Review Main window (Figure 4-34).
2. Click the **Library Match** tool to overlay the library spectrum with the peak spectrum.
Figure 4-35  Overlaid Spectra

The black lines represent the library spectra. No visible red in the overlaid spectra indicates a good match.

**Note:** *The colors displayed in your software may differ from those described here.*

3. To get another view of the library match, click the **Results** tool (see Figure 4-35). The Results window appears (Figure 4-36) with the Library Match table.

4. In the Results window, click the **Match Plot** tab (see Figure 4-36). The Library Match displays the peak spectrum overlaid with any possible matches to the library spectra (Figure 4-37).
5. Click the **Library Match** tab in the upper table and scroll down the list in the Library Match table to see the results for each peak. The Library Match plot appears for each peak (Figure 4-37).
Figure 4-37  Library Match Plot for Each Peak

**Note:** You can normalize the spectra to visually check the match. Right-click in the Library Match plot, then select Properties from the context menu. The Plot properties dialog box appears. Click the Scaling tab, then select Normalize X or Normalize Y.

6. In the lower pane, click the Triple Plot tab (see Figure 4-37). The Triple plot shows the peak spectrum, the library spectrum, and the difference spectrum, which shows the difference between the peak spectrum and the library spectrum (Figure 4-38).
7. Save the results so you can print them. To save the results, select **Save** from the File menu, then select **Result**.

8. Exit Review by clicking the **Close** button.

**Next Steps**

You can now proceed to [Chapter 5, Printing Reports](#), to print your results.
5
Printing Reports

When you want to print a report with PDA data (using Millennium®32 software), you can:

• Preview the report before printing it, which allows you to cancel printing the report before it is actually printed.
• Print in the background, which allows you to perform other tasks while the report is printing.

5.1 Previewing a Report

To preview a report before printing it:

1. Go to the Project window (Figure 5-1), which you opened in Chapter 2, Viewing PDA Data. If the Project window is minimized in the Windows taskbar, maximize it.
2. Click the **Results** tab (see Figure 5-1). The Results window appears in the Project window.

3. Select the data you want to print, then click the **Preview** tool (see Figure 5-1). If the project does not contain any report groups, you are prompted to add the default groups to the project (Figure 5-2). Click **Yes**.

4. The Open Report Method dialog box appears (Figure 5-3). Select **Use the following Report Method**, select **PDA Default** from the drop-down list, then click **OK**.
Figure 5-3  Open Report Method Dialog Box
A preview of the printed report appears (Figure 5-4).

5. You have the following options:
   • If the report looks the way you want it, click the Print tool (see Figure 5-4). The Windows Print dialog box appears. Make sure that the correct settings are checked, then click OK. A report similar to the one in Figure 5-7 prints.
   • If you want to change the way your report looks, you can modify it by using the Report Publisher. For details, refer to the “Report Publisher” topic in the Millennium Online Help Find tab.
   • To exit without printing, click Close, then select Exit from the File menu.
5.2 Background Printing

To print in the background:

1. Go to the Project window (Figure 5-5), which you opened in Chapter 2, Viewing PDA Data. If the Project window is minimized in the Windows taskbar, maximize it.

2. Click the Results tab. The Results window appears in the Project window.

3. Select the data you want to print, then click the Print tool in the Project window (see Figure 5-5). The Background Processing and Reporting dialog box appears (Figure 5-6).
4. Make sure that Print and Use specified report method are selected in the Reporting section.

5. From the drop-down list next to Use specified report method, select PDA Default, then click OK. A report similar to the one in Figure 5-7 prints.
Sample Information

SampleName  Mixture
Vial  4
Injection  1
Injection Volume  5.00 ul
Channel  996
Run Time  5.0 Minutes

Sample Type  Unknown
Date Acquired  01/05/1996 6:44:28 PM
Acq Method Set  PeakPurity
Processing Method  Library_Matching_Only
Date Processed  07/16/1999 1:30:05 PM

Auto-Scaled Chromatogram

Peak Results

<table>
<thead>
<tr>
<th>Name</th>
<th>RT</th>
<th>Area</th>
<th>Height</th>
<th>Amount</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak1</td>
<td>1.387</td>
<td>232049</td>
<td>431997</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peak2</td>
<td>2.166</td>
<td>181615</td>
<td>281480</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peak3</td>
<td>3.591</td>
<td>300906</td>
<td>387310</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

PDA Result Table

<table>
<thead>
<tr>
<th>Name</th>
<th>RT</th>
<th>Purity Angle</th>
<th>Purity Threshold</th>
<th>Match1 Spec</th>
<th>Match1 Angle</th>
<th>Match1 Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak1</td>
<td>1.387</td>
<td>Methyl Pemben</td>
<td>0.314</td>
<td>1.006</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peak2</td>
<td>2.166</td>
<td>Benzoic Acid</td>
<td>0.340</td>
<td>1.007</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peak3</td>
<td>3.591</td>
<td>Propionitrile</td>
<td>0.050</td>
<td>1.009</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 5-7 Sample Report
Index

**Numerics**

3D Channels table 27, 27, 102
   adding to library 80
   enlarging 80
   for library matching 102
3D data 23, 26
   3D plot 29
   viewing 27, 27
3D Plot
   exiting 34
   maximizing 34
   rotating 34
3D plot colors 29
   sample 30
3D Plot tool 28
996 Photodiode Array detector 15
   Waters 996 PDA Detector Operator’s Guide 18

**A**

Absorbances
   different wavelengths 47
   legend 23, 29
   maximum 50
Acquisition time 27
Adding spectra to library 79, 85
Apex spectrum 65, 66, 103
   zoomed 66
Apply Method Set tool 28, 81, 89
Applying Method Set 81, 89
AutoThreshold parameter 65

**B**

Background printing 113
Backup set, restoring 20
Baseline noise 35, 72

**C**

Calculating peak purity 48
Calibration curves 17
CD-ROM (for PDA software) 18
Channel tables 23
Channel View table 26
Chromatogram plot 23, 27, 35, 40
Chromatograms
   at different wavelengths 38
   deriving 50
   displaying peaks 72
   extracting 38
   full view 36
   integrated 63
   marker 39
   Max Plot 50, 53
   overlaid 41
   plot 23, 27, 35, 40
   zooming 35
Client/Server 15
Comparing spectra 46, 46
Configuration Manager 19
   refreshing 21
Contour plot 23, 27
   colors 29
   displaying 26
   zooming 35
Creating a library
   assigning name 79
   flowchart 77
Data
- acquisition 17
- acquisition time 27
- displaying 24, 26
- sample name 27
- sample PDA 18
- sample type 27
- viewing 23
- zooming 35

Deriving chromatograms 50

Displaying
- 3D plot 30
- apex spectra 65
- chromatograms at different wavelengths 39
- Contour plot 23, 26
- library versus data file spectra 107
- peaks 50, 72
- Purity plot 71
- three-dimensional data 29

Extract a Max/Tic Plot tool 52
Extract Chromatogram tool 28, 39
Extract Spectrum tool 28, 42

Extracting
- chromatograms 38
- spectra 41

Flowcharts
- library creation 77
- library matching 78
- peak purity testing 49

Full View command 36
Full View tool 28

Hardware
- for Millennium system 15
- Waters 996 PDA Detector 18

Icons, See Tools
Installing Photodiode Array Option 18
Integrate tool 28
Integrated chromatogram 63
Integration 17
- minimum height and area 58, 96
- rejecting peaks 57, 95
- selecting area for 94
- start and end times 94
- with library matching 101

Interpreting
- library matching results 102
- peak purity results 65

Lamda max 50, 66
Legend for absorbances 23, 29

Library
- adding spectra 79, 85
- creating 79
- creating, flowchart 77
- name 83
- spectrum 107

See also Library matching
Library Match plot 106
- normalized 107
Library Match table 17, 105
Library Match tool 28
Library matching 76
- flowchart 78
- performing 101
processing method for 86, 93
results 102, 102, 102, 103, 108
selecting 92, 98
Login dialog box 19
Login window 19

M

Markers
chromatogram 39
spectrum 42
Match angle 102
Match threshold 102
Max Plot chromatogram 50, 53
Maximizing
3D Plot window 34
Review 26
Review Main window 26
Maximum absorbance 50
Maximum impurity
point of 74
spectrum 66
Maximum Impurity Pass 1 tool 28
Method Set
applying 81, 89
opening 81, 89
saving 63, 100
Method Set tool 28
Millennium32 Online Help 16, 16, 16, 16
Millennium32 Online Help tool 28
Millennium32 PDA software 15, 15, 15, 15
enabling 18
prerequisites 18
tools 28
Millennium32 Photodiode Array Option 18
Millennium32 Read Me First 16
Millennium32 references 16
Millennium32 software 15, 15, 15, 15
base LC software overview 15
features 15
icons 28
Login window 18
Millennium32 Online Help 16
PDA software overview 16
references 16
Restore program 18
tools 28
Millennium32 Software Getting Started
Guide 16
Millennium32 System
Installation/Configuration Guide 18
Minimum area 58, 96
Minimum height 58, 96
Modifying
processing method 76, 86, 90
reports 112

N

Noise interval 61, 98
Normalized
Library Match plot 107
spectra 46

O

Online help for Millennium32 software 16
Opening
Method Set 81, 89
PDA_Default project 24
project window 50
Overlay tool 28, 41
Overlying
chromatograms 41
spectra 44

P

Password 19
Index

PDA detector 15
PDA Review window, accessing 26
PDA software 16
  option CD-ROM for 18
prerequisites 18
PDA_Default project 18, 24
  loading sample data 18
  restored 21
Peak purity 48
  interpreting results 65
  processing method 54, 93
  selecting 60
  testing, flowchart 49
  viewing results 65
Peaks
  apex 74
  minimum height and area 58, 96
  viewing 50, 72
  viewing library match results 106
Peaks table 64, 72, 102
Photodiode Array Option 18
Plot Properties dialog box 37
Plots
  3D 29, 29
  chromatogram 23, 27, 40
  contour 23, 26, 27, 29
  full view 36
  library match 106
  purity 71
  spectral 17, 23, 27, 43, 46, 84
  triple 107
  zooming 35
PowerStation 15
Prerequisites for Millennium32 PDA software 18
Preview tool 110
Previewing reports 110
Print tool 28
Printing 109
  background 113
report preview 110
Processing method
  for library matching 76, 86, 93
  for peak purity 48, 54
  modifying 76, 86, 90
  name 62, 100
  saving 63, 100
  tool 28
  wizard 54, 93
Processing Method Wizard tool 28, 93
Project window 23
  minimized 50
  opening 50
  Review Data selection mode 25
  with results 110, 113
Projects
  opening 24, 50
  PDA_Default 18, 21, 24
  restoring 18
Purity angle 64, 65, 72, 72
Purity plot 71, 72
Purity threshold 64, 65, 72

Q
Quantitation 17

R
Reference information for Millennium32 PDA software 16
Report Publisher 112
Reports
  modifying 112
  preview 112
  printing 109
  sample 115
Requirements for Millennium32 PDA software 18
Restore
program 18
Project wizard 20
tool 20
Restoring projects 18
Results
library matching 102, 102, 103, 105, 108
peak purity 65
saving 108, 108
tool 28
Results window
library matching 105
Project window 110, 113
Purity plot 71, 71
with maximum impurity 74
Review
maximizing 26
menus 27
summary 17, 23
tools 27
Review Main window
maximizing 26
parts of 27
peak purity results 64
tools 28
Rotating 3D Plot 34

S
Sample
3D plot 30
name 27
reports 114
type 27
Saving
method set 63, 100
processing method 63, 100
results 108
zoom parameters 37
Scaling tab 37

Selecting
library matching 92, 98
peak purity testing 60
Setting noise interval 61, 98
Shortcuts 27, 28, 28
Spectra
adding to library 79
apex 65, 65, 103
comparing 46
comparing library versus data file 107
extracting 41, 41
marker for 42
matching results 105
maximum impurity 66
normalized 46, 107
overlaid 44, 66, 68, 104
shape differences 46
zooming 35
Spectral Contrast angle 72
Spectral homogeneity 48, 65
Spectral plot 17, 23, 27, 43, 84
normalized 46
zooming 35
Spectral table 17, 27, 45, 46, 84
Spectrum Index 23, 65, 103
Spectrum matching. See Library matching
Spectrum Points table 17, 47
Spectrum Review 17, 27
See also Spectral plot

T
Tables
3D Channels 27, 102
Channel 23
Channel View 26
Library Match 17, 105
Peaks 64, 72, 102
Spectral 17, 27, 45, 46, 84
Spectrum Points 17, 47
Taskbar 50
Three-dimensional data
  in Contour plot 26
  viewing 23, 27
Three-dimensional data
  3D plot 29
  viewing 27
Threshold criteria 65, 103
  interpreting 65, 103
Tools for Millennium software 28
Triple plot 107, 107

Unzoom tool 28
Unzooming windows 36
User name 19

Viewing
  apex spectra 65
  chromatograms 39
  contour plot 26
data 23, 24
  library versus data file spectra 107
  matches to library 105
  maximized Review Main window 26
  peaks 50, 72
  projects 25
  Purity plot 71
  report preview 110
  Spectrum Index 103
  three-dimensional data 27
  zooming and unzooming data 36
Views
  full plot 36
  maximized Review Main window 26
  saving parameters 37
  zoomed 35

W
Waters 996 PDA Detector 15
Waters 996 PDA Detector Operator’s Guide 18
Wavelengths, marker for 39
Windows
  full view 36
  Login 18
  maximizing 26
  Project 23, 25, 50, 110
  rescaling 36
  Results 71, 105, 110
  Review Main 27
  unzooming 36
Windows taskbar 50
Wizards
  processing method 54, 93
  restore project 20
Workstation 15

X
X-axis 26, 72

Y
Y-axis 26, 72

Z
Zoom box 35
Zoom parameters 37
Zooming
  apex spectra 68
  plots 35